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ВВЕДЕНИЕ

Одним из наиболее распространенных типов программ для работ с графикой являются графические редакторы. Графический редактор - компьютерная программа позволяющая ее пользователю создавать и редактировать изображения на экране компьютера и сохранять их во многих популярных форматах, например JPEG, PNG, GIF, TIFF.
Некоторые графические редакторы специализируются на редактировании фотореалистических изображений, в то время как другие более "заточены" на создание и редактирование рисунков.
Некоторые из наиболее распространенных инструментов графических редакторов позволяют произвести следующие редакции:
- выделение региона изображения для редактирования;
- рисование линий с помощью кисточек разных цветов, размеров, формы и с различным давлением.
- заполнение нужных регионов цветом, градиентом цвета или текстурой;
-выбор цвета используя различные цветовые модели (например RGB, HSV) ;
-делать надписи разными шрифтами;
-удалять царапины, грязь, морщины, эффект красных глаз и другие несовершенства изображений;
-составлять изображения используя слои;
-конвертировать изображения в различные форматы файлов;
- применять фильтры для достижения различных эффектов.
Целью курсовой является : проведение изучения наиболее известных графических редакторов, используемых в современной практике.
Задачи работы:
- изучить понятие и сущность графических редакторов;
- изучить свойства основных графических редакторов, таких как программ PCAD и CirCad (для создания радиосхем и разводки печатных плат), AutoCAD (чертежи), ProtoCAD (стереометрия) и др.
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1 ПОНЯТИЕ И КЛАССИФИКАЦИЯ ГРАФИЧЕСКИХ РЕДАКТОРОВ
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Графические редакторы - это инструменты компьютера для получения графических изображений: рисунков, картинок, чертежей, диаграмм, графиков и т.д., которые получаются на экране монитора и могут быть напечатаны. Графические редакторы (ГР) - это программы для создания и редактирования на ЭВМ графических изображений.
Виды графической информации: рисунки, схемы, чертежи, фотографии, карты, объёмные изображения и т.д.
Рисунок - образное представление объектов реального или вымышленного мира. Рисунки могут быть как статическими (неподвижными), так и динамическими (движущимися).
Фотография-полное графическое изображение объектов реального мира.
Схема - условное изображение объектов, процессов, систем и т.п.
Чертёж - схематическое изображение объекта с точным сохранением геометрических пропорций.
Средствами машинной (компьютерной) графики создаётся как печатная продукция, так и рекламные ролики, видеоклиппы, мультфильмы (анимация) и др. Все современные компьютеры снабжены аппаратными и программными средствами получения графических изображений. Аппаратные средства включают в себя видеомонитор (как правило, цветной - типа EGA, VGA, а лучше SVGA), видеокарту (видеопамять 256К,512К, 1М и более), накопитель на жёстком магнитном диске, процессор, ОЗУ, клавиатура, мышь и другие составные части компьютера. От качества видеосистемы зависит качество изображения, палитра цветов, максимальное разрешение монитора.
Среди графических редакторов, "рисовалок", есть мощные профессиональные программы (Adobe Photoshop, Adobe Illustrator, 3D Studio, CorelDraw), очень большие, с массой вспомогательных программ и всяческих дополнительных эффектов (за это их называют графическими пакетами). Есть более простые и более компактные - Paintshop Pro, Photofinish или Paint из состава Windows. Графические редакторы включают в себя два типа: растровые (Adobe Photoshop,Paintshop,Paint), рисующие изображение по точкам, для каждой из которых отдельно заданы её цвет и яркость; векторные, рисующие сразу целую линию - дугу, отрезок прямой, а сложные линии представляют как совокупность таких дуг и отрезков. Векторные графические редакторы (CorelDraw,Adobe Illustrator) позволяют проделывать очень сложные трансформации формы рисунка, сжатия и растяжения, любые изменения размера, преобразования контуров. В них легко сочетать изображения с разного рода надписями, произвольным образом размещенными (по дугам или иным кривым, под любыми углами).
Но для обработки фотоизображений они непригодны. Используют их при изготовлении всех видов эмблем, товарных знаков, в книжной, журнальной и рекламной вёрстке любой сложности. Растровые программы используют, когда надо обрабатывать сканированные изображения-картины, рисунки, фотографии. Основной упор делается на ретуширование изображений, коррекцию цветов, подбор цветов, подбор оптимального контраста, яркости, чёткости, на разного рода размывки и затуманивания, игры со светотенью, составление коллажей. Но с формой объектов они работают плохо. Этот профессиональный пакет стал основным инструментом для большинства тех, кто занимается компьютерной обработкой изображений. Photoshop - это не просто полезная и удобная программа, но и платформа для множества надстроек и расширений. Adobe Photoshop CS 8.0
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Таблица 1- Краткая характеристика основных функций графических редакторов
	ТИП
	ПРОГРАММА
	Сфера применения
	Возможности

	
	
	
	Графики и диаграммы
	Создание рисунков
	Работа с растром

	I
	MS WORD
MS EXEL
HARVARD GRAFICS
	Графики и диаграммы
	+
	-
	-

	II
	ADOBE PHOTOSHOP
PAINT BRUSH
COREL PHOTO PAINT
	Создание и редактирование рисунков, схем, чертежей, редакция фотографий и растров
	-
	+
	+-

	III
	COREL DRAW 5.0
	Создание и редактирование диаграмм, графиков, рисунков, схем, чертежей, редакция растров
	+
	+
	+-
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Наиболее широко используемый для оформления научных работ и демонстрации полученной информации вид графических изображений — графики и диаграммы. Многие современные программные продукты отличаются таким свойством как «2 в 1», когда средства для рисования включены в текстовый редактор и вынесены в отдельное приложение. Наиболее популярные и известные из них — графические приложения к программам MS WORD 6.0 и выше, MS EXCEL, MS WORK 97, Lexicon 97. На примере WORD 97 и продемонстрируем процесс создания графической формы.
Схема построения и редактирования графика или диаграммы в этом редакторе очень проста: лист таблицы данных - выбор типа диаграммы - готовая диаграмма.
Построение диаграммы происходит в автоматическом режиме по мере заполнения листа таблицы. При всей простоте, эта схема редактирования дает достаточно широкий спектр возможностей — от простого линейного графика до сложной трехмерной диаграммы. Подобные редакторы позволяют дополнить изображение пояснительными надписями в соответствии с желанием автора. Так, например, можно указать варианты расположения значений по осям X, Y или Z, выбрать шкалу деления и расположить метки данных непосредственно на соответствующих столбцах диаграммы или у поворотных точек графика. Имеется возможность ввода в изображение пояснительных под-писей (к осям или конкретным элементам) как в виде легенды, так и в виде текстовых вставок. Для редактирования изображения или его элементов необходимо выделить объект, а затем через меню «Формат» выбрать необходимые параметры.
Графическое приложение, включенное в состав текстового редактора WORD, позволяет автоматически вставлять изображение в текст (в виде кадра, рисунка или файла), что выгодно отличает его от самостоятельных графических оболочек (MICROSOFT EXCEL). Кроме того, нет необходимости в выходе из основного документа, создаваемого в WORD. Из недостатков данных оболочек стоит отметить ограниченный набор функций по сравнению с самостоятельными графическими редакторами для DOS (Grafics, Harvard Graphics и др.). Впрочем, возможности, предлагаемые графическими редакторами для WINDOWS, достаточны для создания графиков и диаграмм, соответствующих требованиям научных изданий.
При необходимости нестандартного подхода к оформлению работ следует обратиться к программам, сочетающим в себе возможности создания векторных графических изображений с элементами дизайна. Это, например, графический редактор COREL DRAW.
Эта программа прочно заняла свое место на рынке, сочетая в себе возможности двух различных типов редакторов. Последовательность построения ледовательность построения изображения здесь примерно та же, что и для предыдущего типа:
лист ввода данных- выбор типа диаграммы - готовая диаграмма + дизайн.
Заметим, что создание векторных изображений возможно только в версиях до 5.0 включительно. В дальнейшем разработчики COREL DRAW посчитали, что большой объем занимаемого дискового пространства и сложные взаимодействия специфичных приложений, затрудняют работу пользователя. В результате были созданы два новых продукта на основе старой версии COREL DRAW. Это собственно COREL DRAW 8.0 и самостоятельный графический редактор COREL CHAT. Редактор COREL DRAW 8.0 больше стал напоминать программу ADOBE ILLUS-TRATOR и не имеет опций для обработки векторных изображений. Поэтому мы рекомендуем использовать хорошо зарекомендовавшую себя 5-ю версию COREL DRAW и на eef примере рассмотрим возможности векторных изображений.
Программа строит графическую конструкцию, используя математические формулы и функции. Создав диаграмму, вы имеете возможность модифицировать ее в соответствии с собственными оригинальными идеями так, что она будет выглядеть как художественный рисунок, сохраняя при этом свою векторную природу. Здесь же можно создать и рисунок, используя обычные инструменты для рисования. По уровню возможностей оформления рисунков COREL DRAW 5.0 сравним с редактором PAINTBRUSH (PAINT) для WINDOWS 95.
Интерфейс программы удобен, построение простейшей диаграммы не вызывает сложностей. Для изменения изображения достаточно выделить редактируемый объект и выбрать необходимые параметры. Эта операция похожа на описанную в примере с приложением MICROSOFT WORD, но, в отличие от нее, здесь присутствует возможность нестандартного подхода к оформлению диаграммы.
Несомненное преимущество редактора COREL DRAW 5.0 — минимальные требования к конфигурации компьютера. Для пользователей, имеющих слабый компьютер (менее IBM386, 4 Mb RAM), подобная программа оптимальна, поскольку позволяет использовать возможности растрового и художественного изображения (рисунок 1).


Рисунок 1 - Возможности растрового и художественного изображения

Если требуется создать рисунок или добавить фотографию, то следует обратиться к третьей группе графических редакторов. Подобных программных продуктов довольно много — от простых, служащих лишь для создания рисунков (типа PAINTBRUSH), до многофункциональных, которые не только создают графические изображения, но и позволяют редактировать многослойные растры, созданные путем наложения нескольких отдельных изображений (редакторы типа ADOBE PHOTOSHOP, ADOBE ILLUSTRATOR или COREL PHOTO-PAINT). Редакторы растрового изображения имеют в наборе готовые шаблоны чертежей и схем. Создав изображение, можно придать ему объемный вид, добавить эффект света или дополнить пояснительными надписями.
Минимальные системные требования к программам подобного типа следующие: процессор Pentium (133 и выше), 16 Mb RAM, 80 Mb свободного дискового пространства, операционная оболочка WINDOWS 95.
Остановимся на программе ADOBE PHOTOSHOP 5.0, которая удобна как адекватный пример редактора растровых изображений и вполне может служить объектом отдельного обзора. Введя растр, т.е. отсканированную фотографию или рисунок, вы имеете возможность модифицировать его по собственному желанию, добавляя детали или накладывая другой объект, изменяя контрастность, яркость, масштаб изображения, создавая эффекты освещения, наложения теней или текстурирования. И это далеко не полный перечень возможностей программ, подобных PHOTO-SHOP. Дополнительным преимуществом данного редактора является его совместимость с другими программами для WINDOWS и возможность экспорта и импорта документов, созданных в других, как графических, так и текстовых редакторах. Функция меню «SAVE COPY» («Сохранить копию») позволяет создавать файлы с расширениями '.BMP, *.JPG, *.TIF и т.д. Это удобно при одновременной работе с разными редакторами и позволяет регулировать размер файла. Функция «Кисть событий» (аналогична «UNDO») помогает исправлять допущенные ошибки, возвращаясь на несколько шагов назад.
Дополнительные возможности дает работа со слоями, т.е. изображениями разных типов (например, текст и рисунок). Функция включения и отключения слоев позволяет добавлять изображение из другого файла или рисунка и редактировать каждый слой отдельно. Используя многочисленные фильтры для модификации изображения, можно получить объемную и реалистичную картинку. По сравнению с другими растровыми редакторами высокого класса, преимущества PHOTOSHOP заключаются в улучшенной цветопередаче, совместимости с другими редакторами и быстродействии.
Подчеркиваем, работа с редакторами растрового изображения, в отличие от редакторов векторного, может производиться только на компьютерах среднего и высокого классов.


Рисунок 2 – Редактор растровых изображений

Все перечисленные выше программы имеют удобный, понятный для рядового пользователя интерфейс и подробную справочную систему. Для редакторов растровых изображений существуют файлы-примеры (Sample), наглядно демонстрирующие возможности данной программы.
Рассмотренные нами редакторы позволяют не только создавать принятые в научных кругах демонстрационные формы, но и оформлять их в соответствии с вашими пожеланиями.
Определив, какой тип изображения вам необходим, вы можете принять оптимальное решение по выбору той или иной графической программы для его создания, и с учетом этого быстро и качественно решать задачи, стоящие перед учеными и специалистами АПК.
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2 СВОЙСТВА ОСНОВНЫХ ГРАФИЧЕСКИХ РЕДАКТОРОВ
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Основные функции графического редактора Paint: создание и редактирование рисунков.
Запуск программы Paint: Пуск ® Программы ® Стандартные ® Paint
Типы файлов данных: *.bmp – сохраняется рисунок с оформлением.
Для работы в графическом редакторе используется мышь.


Рисунок 3 - Интерфейс Paint

Заголовок – название программы Paint, системное меню (значок программы) и кнопки управления окном программы. В заголовке Paint отображается также название рисунка.
Строка меню – в меню сгруппированы все команды по редактированию рисунка.
Панель инструментов включаются в меню Вид ® Набор инструментов.
Палитра цветов включаются в меню Вид ® Палитра.
Рабочее поле содержит окно документа.
Строка состояния сообщает о режимах работы программы.
Примечание. Кроме Рабочего поля, все элементы окна Paint необязательны, т.е. могут быть убраны с экрана.
Основные команды по работе с рисунком
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Создание при открытии Paint. Откройте Paint, при этом сразу же создается новый рисунок.
Создание через меню Файл. Файл ® Создать.
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Открытие из Paint: запустить графический редактор Paint и выполнить команду Файл ® Открыть.
Открытие из Проводника. В Проводнике открыть диск (папку), где находится рисунок, и сделать двойной щелчок по значку рисунка.
Открытие недавно открывавшегося рисунка: Пуск ® Документы ® <щелкнуть по названию рисунка>.
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Сохранение нового рисунка. В меню Файл ® Сохранить как ® <в поле Имя файла набрать название рисунка> ® Сохранить.
Сохранение изменений в рисунке. Файл ® Сохранить.
Сохранение рисунка под другим именем. Файл ® Сохранить как ® <ввести новое имя> ® Сохранить.
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Параметры страницы: Файл ® Параметры страницы. В диалоговом окне Параметры страницы задаются поля страницы, например, верхнее поле 2,5 см, нижнее 2 см, левое 3 см, правое 1,5 см. А также, выбирается размер печатной страницы (А4, А5 или др.) и ориентация страницы (книжная или альбомная).
Область рисунка – это часть страницы, доступная для рисования.
Инструменты графического редактора Paint
Карандаш рисует тонкую линию
Ластик стирает рисунок
Распылитель наносит капельки краски.
Заливка при помощи этого инструмента можно закрасить цветом ограниченную область рисунка. Границей для «разливающейся» краски будет непрерывная линия или область другого цвета. Если линия границы области имеет разрыв, краска «прольется» дальше.
Прямоугольник - для рисования прямоугольников. Если рисовать инструментом Прямоугольник c нажатой клавишей Shift, то будут получаться квадраты — прямоугольники с равными сторонами.
Эллипс - это сплющенная окружность. Используется для рисования окружностей. Если рисовать инструментом Эллипс c нажатой клавишей Shift, то будут получаться круги.
Инструмент Линия.
Настройка инструментов графического редактора Paint
Цвет фигур задается левой кнопкой мыши в Палитре цветов. Щелчком правой кнопки мыши выбирается цвет фона.
Меню настройки инструментов позволяет использовать дополнительные возможности работы с инструментом.
Меню настройки инструментов Линия и Кривая позволяет выбрать необходимую толщину прямых и кривых линии, а также границ замкнутых фигур.
Меню настройки инструментов Прямоугольник, Эллипс, Скругленный прямоугольник, Многоугольник, с помощью которых рисуются различные замкнутые фигуры, позволяет установить тип закраски:
- только границы;
- фигура с границами основного цвета, закрашенная цветом фона;
- фигура с границами и заливкой основного цвета.
В меню настройки Кисти можно выбрать различные профили линии: круг, прямоугольник, «перо» — разного размера.
Меню настройки Ластика позволяет подобрать его размер.
Работа с фрагментами рисунка
Инструмент Выделение используется для обозначения границ фрагмента рисунка:
- для выделения прямоугольной области;
- для выделения произвольной области.
В меню настройки инструментов можно выбрать выделение с фоном, или без фона.
Команда Отменить возвращает рисунок в то состояние, которое было до того, как вы выполнили неудачное действие (Правка - Отменить)
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GIMP прекрасно работает с графическими планшетами и другими устройствами ввода.


Рисунок 4 - Графический редактор GIMP
Преимущество GIMP - Многообразие поддерживаемых форматов, предварительный просмотр, слайд-шоу, поддержка фильтров Adobe Photoshop, множество функций и эффектов, малый “вес”.
Динамика кистей. Любой кисти можно задать степень дрожания, кисти могут реагировать на степень надавливания, скорость движения и изменять свой цвет, размер, жесткость и непрозрачность в произвольном порядке.
Собственный формат файлов XCF поддерживает совершенно все возможности графического редактора. Может сохранять в себе текст, каналы, контуры, и сами слои изображения.
Удобная работа с буфером обмена. Содержимое буфера обмена сразу можно превратить либо в новое изображение, либо можно использовать как кисть или текстуру для заливки.
Портативная версия редактора. У стационарной и портативной версий одинаковые возможности. Настроив редактор «под себя» лишь один раз, каждый сможет пользоваться настройками именно там, где захочет.
GIMP может перетаскивать практически все, что вы видите на экране. Вы можете даже перетащить цвет с панели инструментов на изображение и в результате все изображение или выделенная его часть будут заполнены выбранным цветом.
GIMP умеет архивировать изображения «на лету». Нужно только добавить к имени файла gz или bz2, и изображение будет сжато. В дальнейшем, GIMP сможет открыть такое изображение как обычное.
Поддержка кистей в формате Фотошопа дает огромные возможности рисования дизайнерам и художникам.
Редактирование выделения. После создания прямоугольного или эллиптического выделения его размеры и параметры можно отредактировать. Можно изменить размеры выделенной области или, например, закруглить края выделения.
Передвижение холста. В холсте изображение можно передвигать за пределы окна, что помогает рисованию по краям изображений. Изображение можно передвигать, пока в каком-либо углу холста не окажется центра изображения. Это очень помогает при рисовании по краям рисунка.
Интуитивный инструмент свободного выделения. Одним инструментом можно создавать как многоугольное выделение, так и выделение «от руки». Все точки соединения выделения можно редактировать перед применением выделения.
Параметр «Ослабить». Возможно не полная отмена предыдущего действия, а его частичное ослабление за счет изменения режима смешивания и непрозрачности.
Инструмент выравнивания. Слои можно выровнять по определенным параметрам, которые нужны именно вам. Правилом выравнивания может быть направляющая, активный слой или контур выделения.
Выделение переднего плана. Очень быстрый и удобный инструмент, который сопоставляет цвета, которые есть на переднем плане, а потом создает выделение только переднего плана. В любой момент границы переднего плана можно переопределить кистью.
Локализация. GIMP переведен на множество языков. Он самостоятельно определит язык операционной системы при установке, и сразу же начнет общаться с вами на вашем родном языке.
Обрабатывать фотографии — одно удовольствие. Создано множество плагинов для стилизации и улучшения качества фотографий. В GIMP собрано большое количество интуитивных инструментов для удобной работы с цветом и композицией фотографий.
Карта изображения. В GIMP стандартной сборки добавлен плагин, который может создавать HTM-разметку и саму карту изображения (image map).
Интеллектуальное обесцвечивание. При обесцвечивании изображения можно выбрать один из предложенных вариантов обесцвечивания.
Поддержка формата файлов PSD обеспечивает хорошую интеграцию с программами, которые не поддерживают формат файлов GIMP.
Инструмент «Контуры». Инструмент служит для создания псевдовекторных кривых. Реализован, пожалуй, гораздо удобней чем в большинстве платных векторных редакторов.
При кадрировании изображения сразу можно выбрать правила, которые помогут хорошо кадрировать изображение. Например, «Правило третьей», «Золоте сечение», «Линии по центру».


Рисунок 5 - Кадрировании изображения

Простое создание собственных плагинов. Любой программист может создать расширение на одном из трех распространенных языков программирования, который сможет расширить возможности редактора. Поэтому таких плагинов создано большое количество.
Реальный размер слоя. При активации одного из слоев, можно увидеть его края, если он даже находится за пределами рабочего холста. Опционально эту функцию можно отключить.
Изменяемые комбинации клавиш. В GIMP можно переназначить большинство горячих клавиш. При включенной функции динамического изменения, горячие клавиши можно поменять просто наведя курсор на пункт меню и нажав нужное сочетание клавиш.
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2.3 Photoshop

Photoshop – это лучшая программа для редактирования растровых изображений как на Масintosh, так и на РС. Неоспоримым является и тот факт, что именно благодаря этому приложению компания Adobe Systems занимает лидирующие позиции в издательском деле, а, кроме того, в свое время ей удалось остаться на плаву и избежать слияния с Quark благодаря все тому же Photoshop. Благодаря Photoshop, даже любой пользователь современного компьютера может вспомнить и о существовании Adobe. А это согласитесь, немало! Да, впрочем, и для профессионалов Photoshop является самым привлекательным продуктом
Интерфейс Photoshop-а может показаться достаточно сложным для новичков. Этот урок покажет Вам что есть что и как ориентироваться в такой громадине как Photoshop.<./p> Прежде чем мы начнем, обращу ваше внимание на то, что я буду демонстрировать, как работать с Adobe Photoshop версии 9 (Adobe Photoshop CS2). Если у вас установлена другая версия Photoshop, у вас не должно возникнуть больших проблем с изучением, так как отличий в версиях не очень много, и те только в интерфейсе и основных функциях. Некоторые графические свойства могут отличаться, но в целом проблем должно быть очень мало, если они вообще будут! Экран приветствия При первом открытии Photoshop вы, скорее всего, увидите "Экран приветствия":


Рисунок 6 - Начало работы в Photoshop
Экран приветствия крайне полезен для новичков, чтобы увидеть, что можно сделать при помощи Adobe Photoshop, хотя в принципе не обязателен. Если хотите, чтобы Экран приветствия не вскакивал при каждой загрузке, снимите галочки с пункта "Show this dialog at startup" в левом нижнем углу. Экран приветствия потом всегда можно вернуть назад, если вы нажмете Help > Welcome Screen. Для начала работы в Photoshop, закройте Экран приветствия. На первый взгляд Photoshop может показаться большим и страшным приложением.


Рисунок 7 – Разделение программы на области

A. Горизонтальное меню - Организованная область меню, разделенная по различным выполняемым типам задач. B. Панель настроек - Содержит настройки, возможные для выбранного инструмента. C. Панель инструментов - Содержит широкий выбор доступных инструментов в Photoshop, а также цвет переднего плана, фоновый цвет и другие функции. D. Окно документа - Окно, которое вмещает редактируемый в Photoshop документ. E. Активная область изображения - Окно документа содержит активную область изображения (показана белым сверху). Это область, в которой работает художник. F. Навигатор - Уменьшенная версия активной области изображения текущего документа. Используется для навигации по большим изображениям или при большом зуме (увеличении). G. Панель цветов - Панель, используемая для выбора цветов переднего и заднего планов для рисования или заливки ими. H. История - Постоянно обновляющаяся запись предыдущих изменений внесенных в документ. Используется для отмены сделанных шагов (Undo) I. Слои - Если бы Photoshop был гигантским чизбургером, слои были бы его начинкой и приправой. Слои в Photoshop позволяют вам работать над отдельными полотнами, позволяя разным вещам проявляться над или под другими. Это всего лишь беглый обзор внутренней структуры Photoshop. Мы рассмотрим все более подробно в последующих уроках.
Чтобы создать новый документ в Photoshop, нажмите File > New из Горизонтального меню. Появится диалоговое окно, такое, как показано на рисунке снизу:


Рисунок 8 - Создание нового документа

A. Имя документа - Здесь укажите имя документа (по выбору) B. Предустановки -Выберите размер документа из ранее установленных C. Размеры документа - Здесь укажите ширину и высоту документа D. Единицы измерения документа - Укажите единицы измерения документа. Для любой типичной работы для веба или на мониторе выбирайте пиксели. E. Разрешение - Укажите разрешение документа. Разрешение обычно означает число точек (или пикселей) на дюйм. При печати вам лучше поставить значение повыше (300 или выше), что также увеличит и размер документа. Тем не менее, для экранной работы или работы в вебе, подходящее разрешение 72. F. Цветовой режим - Укажите цветовой режим документа. Если только вы не собираетесь делать специальную печать, вам лучше всего работать в режиме RGB Color (Red/Green/Blue). G. Содержание Фона - Укажите тип фона вашего документа. Диалоговое окно, показанное выше, создаст документ размером 800х600 пикселей с белым фоном. Имя документа будет "Document Name", а разрешение будет наиболее подходящим для экранной работы. Сохранение и закрытие документа Photoshop Чтобы сохранить документ Photoshop, нажмите File > Save из Горизонтального меню. Во время сохранения, убедитесь, что ввели имя документа, которое позже узнаете и также выберите формат "Photoshop (*.PSD)" . Выбор этого формата обеспечит сохранение у документа всех атрибутов Photoshop, а также информацию о слоях, так чтобы вы смогли потом работать с ним.Обратите внимание, что файлы формата PSD не совместимы с веб браузерами и другими приложениями, и для таких целей вам придется сохранять файлы в другом формате. Это мы опишем в других уроках. Чтобы закрыть документ, нажмите File > Close из Горизонтального меню. Чтобы закрыть все открытые документы, нажмите File > Close All.
Панель инструментов Adobe Photoshop CS3
1) Move Tool – предназначен для выбора слоёв и манипуляциям с ними, например, с помощью него мы перетаскиваем слои по документу.
2) Rectangular Marquee Tool – предназначен для выделения области документа (у этого инструмента есть несколько разновидностей выделения: прямоугольником, овалом, колонкой или строкой).
3) Lasso Tool – он в свою очередь нужен для выделения более сложной формы. У этого инструмента, также есть несколько разновидностей: лассо – выделение будет следовать за траекторией курсора; полигональное лассо – выделение осуществляется с помощью указания вершин; магнитное лассо – оно само будет пытаться определить границу объекта, которое выделяется.
4) Magic Wand Tool – эта магическая палочка выделяет область одного цвета (чувствительность может задаваться).
5) Crop Tool – кадрирование области документа.
6) Pencil Tool – карандаш, название говорит само за себя, для рисования. Также есть другие разновидности: карандаш и кисть.
7) Clone Stamp Tool – клонирование области. Очень полезный инструмент для ретуширования фотографии.
8) History Brush Tool – оригинальный инструмент для взаимодействия с историей изменения документа. Проявляет в определённой области то что было раньше, например, до наложения фильтра резкости.
9) Eraser Tool – иными словами «стёрка».
10) Gradient Tool – градиентная заливка. Вторая разновидность инструмента – заливка однородным цветом (инструмент применяется к выделенной области)
11) Blur Tool – размытие кистью. Другие разновидности этого инструмента: наведение резкости и вытягивание кистью.
12) Dodge Tool – высветление области. Другая разновидность инструмента: затемнение.
13) Pen Tool – перо. Предназначено для построения и редактирования пути.
14) Horizontal Type Tool – инструмент для создания/редактирования текста. Набирать текст можно, как горизонтальный, так и вертикальный
. 15) Path ion Tool – тоже самое что и Move Tool, только предназначен для путей. Есть разновидность инструмента для выделения отдельных точек пути.
16) Ellipse Tool – создание геометрических фигур.
17) Notes Tool – создание заметок в документе.
18) Eyeper Tool – измерение цвета точки.
19) Hand Tool – «лапка» для перемещения по документу.
20) Zoom Tool – инструмент масштабирования документа (приближает/удаляет зрителя).
21) Default Foreground and Background Colors – устанавливает изначальные цвета для фона и переднего планов. Switch Foreground and Background Colors – меняет местами эти цвета между собой.
22) Set Foreground Color / Set Background Color – установленные значения цвета на данный момент.
23) Edit in Quick Mask Mode – включает/выключает режим быстрой маски.
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Corel DRAW — мощный графический редактор с функциями создания публикаций, снабжённый инструментами для редактирования графики и трёхмерного моделирования.
Одной из ключевых функций Corel Painter является движок RealBristle Painting System, который дает возможность пользователю регулировать не только толщину и жесткость кисти, но также и параметры самого холста. Таким образом, с помощью Корал Паинтер можно добиться эффекта рисования на бумаге, картоне или ткани. Данный графический редактор поддерживает архитектуру слоев Adobe Photoshop, что позволяет экспортировать его документы в формат PSD или открывать эти файлы с сохранением информации о слоях, альфа-каналах, группах и т.д.
Corel Paint Shop Pro предназначен для обработки фотоснимков, однако позволяет работать и с векторной графикой. В состав графического редактора включены инструменты загрузки снимков из фотокамер, а также органайзер, позволяющий систематизировать изображения на жестком диске.


Рисунок 9 - Систематизация фотографий в Corel Paint Shop Pro

С помощью инструмента Organizer можно указывать папки на жестком диске, содержащие графические файлы. Их миниатюры добавляются на панель, запоминаясь в базе данных. Программа позволяет создавать собственные метки, с помощью которых можно производить дополнительную систематизацию данных. Каждому фото допускается присвоение нескольких меток. Можно также указывать снимкам рейтинг.
Удобно реализован поиск изображений. Вы можете ввести какое-либо слово в строку быстрого поиска или, нажав на значок с изображением бинокля, создать сложный запрос. В качестве условий поиска может выступать дата съемки, имя и размер файла, тип документа, а также метка и рейтинг. Критериями вхождения данных могут выступать совпадения, отсутствия, а в случае ввода текстовых параметров можно указывать начало или конец строки. Результаты поиска сохраняются в группе Saved Search, что является аналогом виртуальных папок в почтовых клиентах.
В органайзер встроен удобный календарь. В рамку обведена текущая дата. Красным цветом выделяются дни, которыми датированы некоторые снимки. С помощью функции Quick Review запускается слайд-шоу. Переход между кадрами сопровождается эффектом затухания. Допускается применение базовых инструментов корректировки снимков в режиме паузы.
Освоение графического редактора заметно упрощается, благодаря наличию панели Learning Center. С помощью нее можно быстро вызывать основные инструменты Corel Paint Shop Pro. Как только вы осуществляете выбор, список команд заменяется подробным описанием текущего инструмента. Все операции раскладываются на несколько шагов, что позволяет без особого труда понять работу любой функции редактора. Разумеется, эта информация дублируется в Справке. Но разве догадается среднестатистический пользователь ее прочитать? В данном случае справочная информация находится постоянно перед глазами, с ней удобно работать. Если вы имеете два монитора, подключенных к системе, то панель Learning Center удобно разместить на втором дисплее. Интерфейс Corel Paint Shop Pro устроен так, что любую панель можно превратить в независимое рабочее окно. Двойной щелчок мышью по заголовку подобного элемента вновь прикрепляет панель к главному окну редактора.
Перед началом работы с фотографиями необходимо указать источник данных. Снимки могут извлекаться из встроенного органайзера, загружаться их фотокамеры или карты памяти, передаваться со сканера, а также быть результатом захвата рабочего стола или отдельных его окон.
Редактор содержит два автоматических режима улучшения качества фотографий. Инструмент One Step Photo Fix производит оптимизацию снимка одним щелчком мыши. Подобный механизм может пригодиться во время пакетной обработки материала, когда физически нельзя уследить за тонкостями корректировки изображений. Другой инструмент имеет название Smart Photo Fix и позволяет улучшить качество снимка путем управления несколькими параметрами.

рисунок 10 - Smart Photo Fix

Улучшение качества фотографий в Corel Paint Shop Pro при помощи инструмента Smart Photo Fix
Во время вызова Smart Photo Fix программа предлагает оптимальные настройки по-умолчанию, названные Suggest Settings. Если вы не согласны с мнением графического редактора, то можете воспользоваться несколькими инструментами корректировки экспозиции. Управление яркостью осуществляется с помощью регулятора Overall. Его воздействие на изображение не уводит фрагменты фото за пределы динамического диапазона. Изменение снимка напоминает корректировку яркости печатающих машин в лабораториях. Регулятор Shadows позволяет проявить тени, а Highlights делает более мягкими светлые участки фото. Кроме того, вы можете регулировать цветовую насыщенность и резкость, а также указывать наиболее темные и светлые точки на снимке.
Среди основных функций улучшения качества фотографий стоит отметить возможность вращения снимка на произвольное число градусов. Вы рисуете на фото линию горизонта, после чего фото поворачивается, согласно вашему указанию. Обрезание границ кадра может осуществляться с учетом заранее определенных соотношений сторон. По-умолчанию используется ландшафтное расположение кадра. Однако вы можете поменять его ориентацию. Под прямоугольником, задающим границы кадра, располагается панель, с помощью которой можно вызывать основные инструменты управления данным процессом.


Рисунок 11 - Кадрирование в Corel Paint Shop Pro

Дополнительные инструменты Adjust включают в себя несколько специфических функций. Во-первых, вы можете исправлять искажения перспективы. Во-вторых, допускается корректировка фиолетового тона на засвеченных областях фотографий. Далее можно избавиться от цифрового шума на снимках. Программа анализирует изображение и автоматически выбирает контрольные зоны, на основе текстур в которых и выполняется снижение зернистости фото. Вы можете самостоятельно менять данные зоны. Чем больше площадь исходной текстуры и чем больше на ней контрастных участков, тем более агрессивный предлагается метод подавления шума. Допускается раздельное указание уровня снижения шума в тенях, бликах и участках со средней яркостью. Кроме того, можно указывать степень применения фильтра, а также, при необходимости, повышать резкость снимка.

Рисунок 12 - Удаление цифрового шума с фотографий в Corel Paint Shop Pro

С помощью функций группы Protect Image можно выполнить частичное снижение зернистости фотографии. Например, вы обрабатываете портрет. Кожа модели должна быть максимально сглажена, не содержать каких-либо шумов. Однако подобные алгоритмы негативно воздействуют на детализацию снимка во всех областях, там, где это не требуется. Например, пропадает текстура волос, одежды. Создается впечатление не очень резкого снимка, что зачастую портит от него впечатление.
С помощью Protect Image вы можете указать определенный диапазон оттенков на круговой палитре. Далее, обращаясь к гистограмме яркости, можно снижать воздействие фильтра в определенных областях. Например, у вашей модели коричневые волосы. Вы указываете сектор палитры между красным и желтым цветом. Далее следует опустить график эквалайзера в зоне теней. После этого, фильтр не будет обрабатывать темно-коричневые тона. Волосы девушки остались резкими.
Инструмент Depth of Field позволяет имитировать малую глубину резкости, получаемую при съемке камерами с большим размером сенсора и объективом с высокой светосилой. Действительно, многие пользователи компактных камер не могут получить портрет, где модель, резко изображаемая на снимке, визуально отделяется от сильно размытого фона. Малый размер сенсора является причиной использования небольших реальных фокусных расстояний, при которых глубина резкости очень велика. Однако с помощью Depth of Field вы можете выделить участок фото, на котором хотите акцентировать внимание зрителя. Допускается круговое, прямоугольное, а также произвольное выделение областей. Размывание фона может имитировать не только циркулярную диафрагму, но также содержащую семь лепестков. Вы можете управлять резкостью перехода между зонами, а также плоскостью размывания.
Corel Paint Shop Pro обладает большим количеством инструментов ретуширования снимков. Вы можете подавлять эффект красных глаз. При этом инструмент воздействует не только на людей, но и на животных, чьи зрачки чаще окрашиваются в зеленый цвет.
На портретных снимках удобно использовать Skin Smoothing, инструмент, автоматически избавляющий кожу от морщин и царапин. Вам предоставляется единственная настройка – управление степенью применения фильтра.

Рисунок 13 - Разглаживание кожи с помощью Skin Smoothing, инструмента, входящего в Corel Paint Shop Pro
Второй инструмент, позволяющий обрабатывать портретные снимки, называется Makeover Tools. Кисть принимает форму двух окружностей, одна внутри другой. Щелкая мышью по поврежденному участку изображения, вы помещаете текстуру, расположенную за пределами внутреннего круга, вовнутрь. Удерживая клавишу Shift, можно перемещать малый круг внутри большого. Клавиша Alt масштабирует кисть. Данный инструмент очень полезен для лечения локальных дефектов, например, родинок.
Иной механизм ретуширования предлагает Scratch Remover Tool. Вы указываете отправную точку, рисуете прямую линию, вокруг которой происходит корректировка текстур. Подобным методом с фотографий удаляются царапины.
Clone Brush позволяет клонировать фрагменты изображения, замещая поврежденные участки качественными текстурами. Щелчок правой кнопки мыши указывает исходную текстуру, которую можно переносить на произвольные места неограниченное число раз.
Инструмент Color Changer позволяет менять цвета отдельных участков фото. На панели материалов вы можете указать определенный оттенок, в который будет перекрашиваться снимок. После этого необходимо указать на снимке точку с цветом, необходимым для изменения. Часть снимка будет закрашена новым оттенком. В настройках инструмента можно указывать допуск цвета, а также мягкость тональных переходов на границах зон применения фильтра. Данный фильтр может применяться в сочетании с произвольным выделением, что обеспечивает его более точное воздействие на изображение.

Рисунок 14 - Изменение цвета внутри локальных участков в Corel Paint Shop Pro

Выделения в Corel Paint Shop Pro могут производиться не только с помощью рисования геометрических фигур, но также путем обведения произвольных областей или по велению волшебной палочки. Выделение может инвертироваться, а также подвергнуться сдвигу на произвольное количество точек.
Corel Paint Shop Pro содержит большое количество эффектов, собранных воедино в специальном браузере. В левой панели в виде древовидной структуры представлены все доступные в редакторе фильтры. Вызов любого элемента открывает панель миниатюр, на которых отображаются различные варианты применения текущего фильтра. Вы не можете менять какие-либо параметры функций, однако наглядность отображения эскизов позволяет быстро выбрать приемлемый набор установок.

Рисунок 15 - Браузер эффектов Corel Paint Shop Pro

Графический редактор содержит большое количество фильтров, имитирующих работу различной техники. Например, вы можете создавать эффект съемки на пленку с применением разных оптических фильтров. Фильтры могут изменять контраст сцены, цветовой баланс. Цветные фильтры усиливают определенный оттенок на фото.
Преобразование в черно-белый режим может применяться с наложением цветного фильтра. При этом какой-то из оттенков более сильно влияет на конечный снимок, повышая яркость в областях своего присутствия. Данный механизм позволяет создавать контрастные сцены с высокой детализацией мелких объектов. Иной способ преобразования фотографий в черно-белый режим заключается в имитации инфракрасной пленки. Данный эффект уместен при обработке портретных снимков.

Рисунок 16 - Имитация инфракрасной пленки в Corel Paint Shop Pro

Стилизация фотографий под старину может осуществляться с применением тонирования в цвета сепия. Вы указываете возраст снимка, а программа автоматически подбирает его цветовую гамму. Кроме того, редактор содержит отдельный инструмент Time Machine, позволяющий имитировать различные фотографии, созданные с 1839 по 1960 годы. По каждому из временных отрезков дается подробное текстовое описание. Вы можете узнать, как в то время производилась съемка, какие особенности были присущие тем или иным эпохам. В состав сюжетных установок входит также и художественная
Corel Paint Shop Pro обладает большим количеством подобных мелких инструментов, помогающих при обработке фотографий в сложных, неожиданных ситуациях. Разумеется, если графический редактор используется только, чтобы убрать красные глаза со снимков и чтобы немного подравнять экспозицию, то сложный программный продукт не нужен.
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ЗАКЛЮЧЕНИЕ

Графический редактор — это программа создания, редактирования и просмотра графических изображений.Для создания рисунка традиционными методами необходимо выбрать инструмент рисования (это могут быть фломастеры, кисть с красками, карандаши, пастель и многое другое).
Графические редакторы также предоставляют возможность выбора инструментов для создания и редактирования графических изображений, объединяя их в панели инструментов
Bit MaP image (BMP) — универсальный формат растровых графических файлов, используется в операционной системе Windows. Этот формат поддерживается многими графическими редакторами, в том числе редактором Paint. Рекомендуется для хранения и обмена данными с другими приложениями.
Tagged Image File Format (TIFF) — формат растровых графических файлов, поддерживается всеми основными графическими редакторами и компьютерными платформами. Включает в себя алгоритм сжатия без потерь информации. Используется для обмена документами между различными программами. Рекомендуется для использования при работе с издательскими системами.
Graphics Interchange Format (GIF) — формат растровых графических файлов, поддерживается приложениями для различных операционных систем. Включает алгоритм сжатия без потерь информации, позволяющий уменьшить объем файла в несколько раз. Рекомендуется для хранения изображений, создаваемых программным путем (диаграмм, графиков и так далее) и рисунков (типа аппликации) с ограниченным количеством цветов (до 256). Используется для размещения графических изображений на Web-страницах в Интернете.
Portable Network Graphic (PNG) — формат растровых графических файлов, аналогичный формату GIF. Рекомендуется для размещения графических изображений на Web-страницах в Интернете.
Joint Photographic Expert Group (JPEG) — формат растровых графических файлов, который реализует эффективный алгоритм сжатия (метод JPEG) для отсканированных фотографий и иллюстраций. Алгоритм сжатия позволяет уменьшить объем файла в десятки раз, однако приводит к необратимой потере части информации. Поддерживается приложениями для различных операционных систем. Используется для размещения графических изображений на Web-страницах в Интернете.
Windows MetaFile (WMF) — универсальный формат векторных графических файлов для Windows-приложений. Используется для хранения коллекции графических изображений Microsoft Clip Gallery.
Encapsulated PostScript (EPS) — формат векторных графических файлов, поддерживается программами для различных операционных систем. Рекомендуется для печати и создания иллюстраций в настольных издательских системах.
CorelDRaw files (CDR) — оригинальный формат векторных графических файлов, используемый в системе обработки векторной графики CorelDraw.
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